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What is the Dynamic Clothing Control 
Plug-in? 
The Dynamic Clothing Control plug-in for DAZ Studio is a plug-in to enable DAZ Studio 
users to work with cloth which has been designed to respond realistically to the 3D 
figure’s movements and poses along with the environment. Once the cloth material has 
been fitted to a 3D model and posed, the material can be processed by a draping 
simulation engine to "drape” or "relax” the cloth material to the model and its position, 
based on the materials own parameters and outside environmental factors such as 
gravity and movements. 
The Control version differs from the free version in that it allows the user to adjust how 
gravity and wind affect the cloth, set collision tolerance, internal pressure, and 
simulation settings. 
The Dynamic Clothing Control plug-in uses technology from OptiTex, a company which 
specializes in 2D and 3D CAD/CAM Fashion Design Software for the clothing and 
textile industry. 

Conventions 
This User Guide describes both the Windows and Macintosh versions of the plug-in. It 
includes several formatting conventions that present information clearly and make 
learning and working with the plug-in easier. 

Unordered Procedures 
Lists or procedures that do not need to be performed in a specific order have bullets 
next to each item, as shown here: 

• Item 1 
• Item 2 

Ordered Procedures 
When you need to follow steps in a specific order, it will have numbers next to each 
step, as shown here: 

1. Do this first... 
2. Next, you have to do this... 
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Keyboard Entries 
If you need to press a specific key on your keyboard, you will see the key label in bold 
letters with the Macintosh key label first followed by a slash and the Windows key label. 
(for example, Cmd/Ctrl.) If you need to press two more keys simultaneously, the 
notation will appear as Key1+Key2 (for example Cmd/Ctrl+V). 

Mac OS Conventions 

The following additional conventions apply for Macintosh users: 
• Where instructions in this manual specify a right-click, Macintosh users may 

press Ctrl while clicking to access the same functionality. 

Commands and Prompts 
Screen prompts, menu and window names, fields, buttons, boxes, etc. appear in bold 
type. The syntax used to demonstrate accessing a palette or submenu is Menu > 
Submenu. For example Edit > Preferences means that you should open the Edit pull-
down menu and then select Preferences to open the Preferences dialog box. 

Tips, Cautions, and Notes 

TIP! Tips contain helpful advice and other information that makes the software 
easier and more enjoyable to use. 

CAUTION! Cautions warn of potential problems that you will want to avoid. 

NOTE! Notes contain other points worth mentioning. 

ReadMe 
At the end of the installation process, the Readme file will automatically appear. This file 
includes late-breaking developments and other information that were too recent to be 
included in the User Guide or Install Notes. Please take a few moments to read this 
information carefully as it may affect how you use the plug-in. 
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Installation - Macintosh & Windows 
This section describes the installation process for the Dynamic Clothing Control plug-in 
on both Windows and Macintosh computers. Before installing the plug-in, you must 
read, understand, and agree to the End User License Agreement (EULA) and learn how 
DAZ protects artists' copyrights. The EULA appears during installation. 
To install the Dynamic Clothing Control plug-in on either a Macintosh or Windows 
system: 

1. If you have the Dynamic Clothing Basic plug-in installed, uninstall it before 
installing the Control version. 

2. (Macintosh only) Unpack the zip file to access the installer. 
3. Double-click on the Dynamic Clothing Control installer icon to start the 

installation. 
4. If a previous version of the plug-in is already installed, you will be prompted to 

remove the current version to prevent possible conflicts. Click on Yes to 
continue. 

5. Read the Welcome screen and click on Next. 
6. Read the Software License Agreement and click on the radio button next to I 

accept the agreement, then click on Next to continue. 
7. Read the Ready to Install text and click on Next.  
8. Once the plug-in has been installed, read the Important notes and click on Next. 
9. In the Completing install dialog, click on the checkbox next to Launch DAZ 

Studio if you want to use the program immediately; click on the checkbox next to 
View the <plug-in> Readme then on Finish to close the installer and view the 
readme. 
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Support 
This manual addresses as many questions about Mimic as possible. Should you need 
it, there are several ways to get additional help. 

Contacting Technical Support 
Need support? Please contact DAZ as follows: 

• Toll Free Phone: (800) 267-5170 
• Local Phone: (801) 495-1777 (Our technical support hours are Monday through 

Friday, from 9:00 a.m. to 5:00 p.m. Mountain Standard/Daylight Time). 
• Fax: (801) 495-1787 
• Online Direct: http://daz.custhelp.com 
• US Mail: 12637 South 265 West, #300, Draper, UT 84020 

Other DAZ Resources 
• Web site: http://www.daz3d.com 
• Support database: http://daz.custhelp.com 
• Community Forums: http://forum.daz3d.com 
• Online Documentation and Tutorials: 

http://artzone.daz3d.com/wiki/doku.php/pub/software/mimic/start 
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Dynamic Clothing Control Overview 
The following pages give an overview of the Dynamic Clothing Control panel and 
associated tabs, followed by a more detailed section on actually using the plug-in. 

Dynamic Clothing Tab 
The Dynamic Clothing tab for the plug-in is accessed by choosing View > Tabs > 
Dynamic Clothing from the menu. The tab can be placed anywhere around the Studio 
window or docked to one of the tab palettes. 

 
The following options are available on the main cloth tab: 

• Active Item - Shows the current active item, such as the name of the selected 
cloth, all items in scene, and all cloth on the figure. 

• Cloth actions affect - Provides a drop-down menu from which to select which 
cloth items are to be affected. 
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• All Selected Cloth - will affect all cloth items selected in the viewport 
• All Cloth on Figure - will affect all cloth items on the figure whether the 

item is selected or not 
• All Cloth in Scene - will affect all cloth items in the scene, no matter what 

figure they are applied to 
• Drape - Starts the process of simulating the clothing material, by running a 

physics engine which "relaxes" the cloth based on the parameters of the cloth 
material.  While draping, a busy cursor and a progress dialog will pop up to give 
the user an indication of how long it will take. 
 
If you do not have a cloth item or the figure selected, you will get the following 
error message. 
 
  

• Clear - Removes the active cloth's cached draping data and resets the cloth to its 
original default initial or auto-rigged state. You will be asked to confirm that the 
draping will be removed. 
 

 
 
If you do not have a cloth item selected, you will get the following error message. 
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• Draping Mode -  
• Single Frame - This mode simply relaxes the cloth based on the current 

figures pose. The greater the changes from the initial pose and the final 
pose, the less accurate the drape will be. You may want to drape the item 
a few times in large pose differences. Good for previewing. 

• Animated - This mode relaxes the clothing materials over a series of tiny 
increments. Because the increments are so small, the changes to the 
material are also much smaller which enables the overall draping 
simulation to be much more accurate. Best for final draping. Use when 
draping over an animation timeline. 

• Collide With - Brings up a selection dialog where the objects that the active cloth 
will collide with can be selected or deselected. 
 

 
• When clicked, the select dialog comes up with Everything selected by 

default. 
 

 
• If the cloth item will not be in contact with specific body parts, deselect 

them in the list by clicking on the plus sign (+) next to the figure/item and 
deselecting parts that will not be needed for the calculations. For example, 
the image below shows the head deselected for a shirt. A pair of slacks 
would probably not need to interact with the head and upper torso. 

©2008 DAZ 3D, Inc. 7 



Dynamic Clothing Control 17 July 2008 

 

 
• Click on Accept to apply the changes or Cancel to accept the original 

selections. 
• All Selectable in Viewport - Enable this option in order to be able to select from 

all items in the scene to be collided with by the cloth. 
• Parameter tabs - Tabs providing access to the more advanced functions of the 

plug-in. 
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Garment Tab 
The Garment tab lists all cloth items in the scene, the figure they are fit to, ability to 
place the cloth items in layers, and selection of any styles. 

 
• Layering - Sets the order of the cloth items to ensure they are layered correctly. 

For example, the image below shows the fitted shirt will be layered over the 
pants. If a jacket was added, it would need to be above the shirt and pants. 
Select the cloth item to move then use the up and down arrows to move it into 
the correct order. 
 

 
• Styles - If the cloth item contains styles, provides drop-down menus for selection 

of the different styles. In the image below, the Fitted Shirt has styles available for 
the buttons, collar, and sleeves. Click on the drop down menu for each item and 
select a style. 
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Panel tab 
The Panel tab provides options for setting how the cloth acts based on what type of 
material it is. The modeled garment is pieced together the same as a clothing 
manufacturer would make the real article of clothing. The individual material sections 
enable the designers to further "tailor" their clothing to be as realistic as the original item 
or actual item would be. Each cloth section can have different properties associated 
with them. In addition, once the options are set, a preset can be saved that will apply 
the cloth properties to the same or another cloth item. 
For example, a well tailored suit will drape nicely on a person when posed in a normal 
standing or walking position. However if the person were to raise their arms high over 
their head, the tailored aspects of the shoulder in the suit would cause bunching above 
the shoulders and pull up on the front of the suit. Likewise if the same person were to 
wear a cotton t-shirt and raise their arms high above their heads, the t-shirt would not 
bunch and have very little distortions of the material and the t-shirt probably wouldn’t 
raise much in the front, especially if it were tucked in. The t-shirt is more stretchable and 
bendable than the tailored suit. 
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The Panel tab has the following options available: 
• Selection - Click on the drop-down menu to the right to select a clothing item in 

the scene, use Ctrl+click to select multiple items to work on simultaneously and 
give them the same characteristics, such as all pieces of a waistband or sections 
of a skirt. 
 

 
 
Or, click on the arrow to the left of Selection to open a panel containing a listing 
of the cloth items in the list, then click on a clothing item in the scene to select it. 
Use Ctrl+click to select multiple items to work on simultaneously and give them 
the same characteristics. 
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You can also choose Tools > Surface Selection (Ctrl+Alt+M) and select 
material zones in the viewport. The Selection field will update based on the 
surface you select. 

• Layer - Lists the layer the article(s) of clothing are on. Higher layers are 
displayed over lower layers. For example, a shirt might be at layer 1 and a pocket 
on that shirt might be layer 2. You can change the currently selected item's layer 
by clicking on the "+" or "-" buttons or by entering a number in the field. 
 
If multiple items are selected, the minimum and maximum layer numbers will be 
displayed such as "<Min 0> <Max 43>" 

• Note: In the Garment tab, if the ordering of the garments changes in the 
"Top to Bottom" layer ordering. The layer number in this pane will be 
affected. If an item of clothing is moved from the top layer order to the 
bottom layer order in the layer ordering panel, then the layer numbers of 
everything moved up the chain will be increased to account for the items 
moving down and vice-versa if the items are moved from the bottom up. 
For example, if the bottom article of clothing Cloth-B has layers 0-5 and 
Cloth-A has layers 6-7. Switching the layering order of those 2 items 
would give Cloth-A layers 0-1 and Cloth-B layers 2-7. This way, the layers 
of items within each cloth item remains consistent with the garment. 

• Cloth Properties - In general the numbers in the parameters represent the 
measure of resistance of the fabric to deforming itself according to the property. 
A small number such as 1 will easily deform where a large number such as 5000 
will resist the property, i.e., it won’t stretch easily, instead it will constrict. The 
default numbers are chosen by the material designers. These parameters give 
the designers the ability to make different materials like cotton, polyester, silk, 
leather, rubber, etc. with more realistic properties. For example rubber might 
easily bend, stretch, and shear, but have a high friction number. 

• Bend Resistance - Measure of resistance the fabric has to bending. 
Small numbers give the fabric section more ability to deform. Larger 
numbers provide stiffer (less bendable) fabric. 

• Shear Resistance - Measure of resistance the fabric has to shearing on 
both the x and y axis’. A Small number gives the fabric more shear-ability. 
For example, "1" will make the item appear baggy and loose fitting. 

• Stretch X Resistance - Measure of resistance the fabric has to stretching 
on the x-axis. A small number gives the fabric a loose fitting look on the x-
axis. A larger number keeps the fabric tight to the figure. 

• Stretch Y Resistance - Measure of resistance the fabric has to stretching 
on the y-axis. A Small number gives the fabric more stretch-ability. For 
example, a "1", will make the item appear baggy and loose fitting with the 
effect of gravity adding to the pull on the fabric. A large number such as 
"5000" will pull the garment very tightly in to the figure. 
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• Damping - Measure of how the fabric has to being damped. A large 
number gives the fabric more damping-ability. An example of damping 
could be a shock-absorber on a car. The shock absorber "dampens" the 
wheel from continually bouncing up and down. This parameter acts similar 
to this on clothing. 

• Shrink X% - Percentage of shrinkage the fabric will experience on the x-
axis. A small number will not shrink the item very much. A larger number 
will cause more shrinkage to occur. 

• Shrink Y% - Percentage of shrinkage the fabric will experience on the y-
axis. A small number will not shrink the item very much. A larger number 
will cause more shrinkage to occur. 

• Weight - Measure of the fabric's weight, heavier fabrics like leather will 
have a greater weight than silk. A small number gives the fabric less 
weight so other parameters (i.e., forces) may have more effect upon the 
item than gravity. Larger numbers will have more gravitational pull. 

• Friction - Measure of resistance the fabric has to sliding upon itself or 
other items. For example, using a small coefficient of friction like 0.010 will 
allow the fabric to slide easily across a surface. 

• Limits - Uncheck the limits box if you don’t want the panel setting sliders 
to be limited. This enables you to set very high or low values if you 
choose. Whether the limits option is on or off is persistent and will be 
remembered. 

CAUTION! When changing settings for a panel, make sure that all applicable 
panels are changed as well to match, otherwise, the cloth will be "torn apart" when 
draped. For example, if you set the Friction on the front right of a waistband to 2, but not 
on the front left or both back pieces. When draped, the front right will resist movement 
while the other parts will try to  

Physics Tab 
The Physics tab provides the ability to set up and modify external forces such as 
gravity and wind, which act upon the garment. 
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The Physics tab has the following options available: 
• Gravity -  

• X times Earth gravity - One of the standard parameters to the physics 
engine is gravity acting upon the garment. On earth at sea level the gravity 
is -9.81 (m/s^2). This slider will adjust the level in multiples of the Earth’s 
gravity of 1.0. 
 
For example, if you are draping clothing on the moon you would set the 
gravity to -0.1667, which is 1/6 the gravity of earth, or -1.62 (m/s^2) 

• Restore Default - This button resets the sliders to their default values. 
• Cloth Wind - 

• Add Wind Direction - Adds a wind source which the cloth will respond to 
similar to how the cloth responds to gravity. The wind source will add 
pressure forces to the cloth from the direction of the source.  Similar to 
how a light adds lighting effects to a scene. Multiple wind sources will be 
averaged and act upon the garment as if coming from a single point. 

• Wind Velocity - This is available on the Parameters tab after selecting the 
wind source in the scene. The velocity determines how fast the wind is 
blowing and how much it affects the cloth based on the cloth settings. The 
default velocity is set at 5. 
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Preferences Tab 
The Preferences tab provides options where the user can set up specific garment and 
simulation draping settings. 

 
The Preferences tab has the following options available: 

• Garment Settings - 
• Self Intersection - When checked, the cloth item will intersect with itself. 

This will cause more bunching of the cloth. When not checked, the cloth 
item will be able to pass through itself in an unrealistic manner but will 
drape much quicker. 

• Collision Tolerance (cm) - This can be thought of as the amount of 
"padding" that is kept between the clothing geometry and the figure 
geometry when draping. A value of 0.2 indicates that the cloth will "hover" 
0.2 cm above any geometry it's colliding with. Changing this setting is 
useful in situations where the figure's geometry can be seen poking 
through the cloth geometry. Increasing the collision tolerance can help 
solve the problem. As a note, setting the value to 0 will make the clothing 
act as if there is no colliding geometry at all. Setting this value too high 
can result in simulation anomalies with the cloth going every which way. 
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• Internal Pressure - This is a measure of how "puffy" the material will be 
when simulated. For example, a down jacket is much "puffier" than a rain 
jacket. The larger the number the more internal pressure is exerted on the 
material and the "puffier” it will appear. 

• Animation Cache Path - This button brings up a standard "Choose 
Folder" dialog to allow the user to choose a folder where the animation 
cache is stored when the scene is saved. This is not where the temporary 
animation cache is store during draping functions, but the location where 
the final files animation cache files are stored. When a saved scene is 
opened at a later time, Studio will look in the selected location for the 
correct draping files to load. 

• Restore Defaults - This button resets the Garment sliders to their default 
values. 

• Simulation Settings - 
• Multi-Item Drape Mode - Determines in what order the cloth items are 

draped, either sequentially (one at a time) or concurrently (at the same 
time). 

• Time Step (sec) - The increment in time segments that the physics 
engine uses for each loop when draping over a single frame. (This option 
will be grayed out when draping over an animated range.) 
 
For example, if you enter 0.01. Each loop of the draping engine will move 
the clock forward 1/100 of a second. 

• Iterations - The number of loops the physics engine will run through a 
calculation using the Time Step as its increment when draping over a 
single frame. If you choose 0.01 sec as your time step, to get the 
equivalent of 1 second of draping you will need 100 iterations. (This option 
will be grayed out when draping over an animated range.) 

• Animation Sub-frames - Only used when draping over an animated 
range. Sometimes the animation sequence is too big of a gap to get good 
draping results. For example, 30 frames per second might not give great 
results so adding a sub-frame increment of 4 would run the physics engine 
4 extra times per frame, giving better details for each frame. (This option 
will be grayed out when draping over an single frame.) 

• Restore Defaults - This button resets the Simulation sliders to their 
default values. 
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Dynamic Cloth Presets 
The settings for a cloth panel or complete cloth item, can be saved as a Dynamic Cloth 
Preset. These presets can then be used by other Pro version users and Basic version 
users (who can't change the presets manually). 
There are two types of dynamic cloth presets: 

• Garment Dynamics Preset - This preset is specific to a cloth item and uses the 
garment's material zones to set the cloth properties. The settings are applied to 
all panels/material zones of the cloth item. It does not set surface properties 
(applying colors, textures, etc.). 

• Fabric Dynamics Preset - This preset can be used on any cloth item to set a 
specific type of fabric, such as cotton, lycra, silk, etc. The settings are applied to 
the currently selected panels/material zones on the cloth item. 

Saving a Garment Preset 
To save a garment preset: 

1. Adjust the cloth settings on the Panel tab for all panels/material zones. 
2. Choose File > Save As > Garment Dynamics Preset from the menu. A default 

save dialog will come up. 
3. Navigate to the folder where you want to save the preset, enter a name in the 

filename field, select a file type of either plain text (.ds) or encrypted (.dsb), and 
click on Save. 

Saving a Fabric Preset 
To save a fabric preset: 

1. Adjust the cloth settings on the Panel tab for any panel/material zone on the 
cloth item. 

2. Make sure the modified panel is selected in the Surfaces tab or choose File > 
Save As > Fabric Dynamics Preset from the menu. A default save dialog will 
come up. 

3. Navigate to the folder where you want to save the preset, enter a name in the 
filename field, select a file type of either plain text (.ds) or encrypted (.dsb), and 
click on Save. 

©2008 DAZ 3D, Inc. 17 



Dynamic Clothing Control 17 July 2008 

Applying a Garment Preset 
To apply a garment preset: 

1. Select the cloth item or any panel/material zone of the cloth item. 
2. Double-click on the garment preset in the Content tab. 

Applying a Fabric Preset 
To apply a fabric preset: 

1. Select the panel/material zone to apply the preset to. To select more than one 
material zone, use Ctrl+click in the Surfaces tab or in the Selection field of the 
Cloth Panel tab. 
 

TIP! Fabric presets are applied only to the currently selected panel/material 
zone. Select multiple zones to apply the preset to more than one zone at a time. 

2. Double-click on the fabric preset in the Content tab. 

NOTE! You cannot apply garment or fabric presets to stitches. 

Using the Dynamic Clothing Control 
Plug-in 
The Dynamic Clothing Control plug-in provides the ability to drape pre-made cloth items 
onto a figure, such as Victoria 4, and adjust settings for gravity, wind, and collisions. 
See the individual sections for more information on each option (i.e., what it does, how it 
affects the cloth, etc.). 

1. Load Victoria 4 into the scene in DAZ Studio. 
2. Activate the Dynamic Clothing Control plug-in by choosing View > Tabs > Cloth 

from the menu. The Cloth Panel will come up. 
3. Decide whether to drape the cloth over a static pose or over an animation 

timeline. Draping over several frames will take longer but will result in a better 
draping action. 

• Static pose - select figure and apply a pose. 
• Animation - activate the Timeline, enable the Advanced View and click 

on the plus sign to add a keyframe to the first frame. Move the scrubber to 
the last frame, apply a pose to the figure, and click on the plus sign to add 
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a keyframe at the last frame. 
 

 
4. Make sure the figure is selected and locate the content folder containing the 

included cloth items. 
5. Double-click on each cloth item to apply it to the figure. 
6. Select each cloth item and check the Parameters tab to ensure it is fitted to the 

figure and fit them if needed. 
 
If loading a non-rigged cloth item (prop), it can be parented to the figure if 
needed. Items such as a tablecloth do not need to be parented. 

7. In the Cloth tab, select which cloth items to affect from the Cloth actions affect 
drop down menu. 
 

 
• All Selected Cloth - will affect all cloth items selected in the viewport 
• All Cloth on Figure - will affect all cloth items on the figure whether the 

item is selected or not 
• All Cloth in Scene - will affect all cloth items in the scene, no matter what 

figure they are applied to – use for non-parented items 
8. Select the draping mode of Single Frame or Animated. 

• Single Frame - This mode simply relaxes the cloth based on the current 
figures pose. Good for previewing and when draping over a static pose. 

• Animated - This mode relaxes the clothing materials over a series of tiny 
increments. Best for final draping and when draping over an animation 
timeline. 

9. If the cloth needs to interact with other items in the scene, such as a floor, chair, 
or non-dynamic clothing, enable All Selectable in Viewport so the items can be 
selected in the Collide With dialog. 
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10. Click on the button next to Collide With.  

 

 
 
The select dialog will come up with Everything selected by default. 
 

 
11. If the cloth item will not be in contact with specific body parts, deselect them in 

the list by clicking on the plus sign (+) next to the figure/item and deselecting 
parts that will not be needed for the calculations. For example, the image below 
shows the head deselected for a shirt. A pair of slacks would probably not need 
to interact with the head and upper torso. 
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NOTE! If you change the cloth styles or remove the current cloth items and 
replace them with different ones, the collide with options will remain the same. So 
if you change from a sleeveless item to a long sleeved item, make sure you re-
enable collision with the arms and hands that you may have disabled earlier. 

12. Click on Accept to apply the changes or Cancel to accept the original selections. 
13. In the Garment tab, check the order of the cloth items to ensure they are layered 

correctly. For example, the image below shows the fitted shirt will be layered over 
the pants. If a jacket was added, it would need to be above the shirt and pants. 
Select the cloth item to move then use the up and down arrows to move it into 
the correct order. 
 

 

©2008 DAZ 3D, Inc. 21 



Dynamic Clothing Control 17 July 2008 

14. If the cloth item contains styles, they will show up in the Styles section. In the 
image below, the Fitted Shirt has styles available for the buttons, collar, and 
sleeves. Click on the drop down menu for each item and select a style. 
 

 
 
Remember to adjust any collide with options as needed based on the selected 
styles (see step 11 above). 
 

NOTE! Each style is a different mesh object so selecting a new style will 
change what textures are required for that style. The garment creator may also 
have saved a default texture with the style itself. You can keep the texture 
applied or use a material preset to change the textures. 

15. Check over the Garment tab to ensure that all settings are correct. 
16. Click on the Panel tab and select a cloth item or cloth piece from the Selection 

menu. Use Ctrl+click to select multiple items that will have the same settings. 
 

 
17. Use the sliders to adjust the Cloth Properties which set the layering and 

measure of resistance that the fabric deforms itself. 
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18. Instead of setting each cloth property, you can apply a garment or fabric preset. 

These presets apply settings for different types of fabric to the cloth item and the 
settings on the Panel tab will changed depending on the applied fabric preset. 
See "Dynamic Cloth Presets" for more on applying garment and fabric presets. 

19. Click on the Physics tab and set the amount of Gravity and add a Wind 
Direction if needed. 
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20. In the Studio Scene tab, select the wind source object. To see it in the viewport, 

you may need to change the background color of the viewport in order to see it. 
 

 
 

 
21. Move the Wind Direction so that it shows which direction the wind is blowing. 

For example, the image below shows the wind source in front of the figure with 
the "fan blades" pointing away from the figure. This tells the cloth engine that the 
wind is coming from behind the figure. You can have the Wind Direction 
anywhere around the figure, as log as the fan blades are pointing in the direction 
the wind is going. 
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TIP! Multiple wind sources are averaged so that the wind seems to be 
coming from one direction. 

22. In the Parameters tab for the wind source, set the Wind Velocity and if needed, 
point it at a figure or other object. A cloth item made of heavy or thick fabric will 
need a higher velocity setting than a cloth item made of cotton or silk. 
 

 
23. Click on the Preferences tab and set the Garment Settings and Animation 

Cache Path. 
• Self Intersection - enable if the cloth will intersect with itself 
• Collision Tolerance (cm) - set the amount of "padding" that is kept 

between the clothing geometry and the figure geometry when draping. 
• Internal Pressure - sets how "puffy" the material will be when simulated.  
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24. Set up the Simulation Settings for iterations and frames. 
• Time Step (sec) - sets the increment in time segments that the physics 

engine uses for each loop. 
• Iterations - sets the number of loops the physics engine will run through a 

calculation using the Time Step as its increment. 
• Animation Sub-frames - Only used when animating and provides a sub-

frame increment for the physics engine giving better details per frame. 
Adjust this as needed as you drape over an animation timeline. 

25. Check the Cloth actions affect field and if All Selected Cloth is selected 
ensure that the correct clothing items are selected in the viewport. To do this, 
click on the cloth item to affect in the viewport, press Ctrl and click on additional 
cloth items if needed. The selected cloth items will be highlighted with their 
bounding boxes. 
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26. Click on the Drape button. A progress bar will come up showing the percentage 
complete and elapsed time. If draping over an animation timeline, the figure's 
pose will change as the animation runs and the cloth will drape accordingly. 
 

 
27. Wait until the simulation is complete or click on Cancel to cancel the operation. 

Some cloth items may require more than one draping operation if the pose is too 
extreme. In such a case, perform a single drape, then an animated drape to 
refine the draping. 
 

 
28. To re-drape the cloth for more detail, move the scrubber back on the timeline to 

where you want to start the draping, then click on the Drape button. 
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29. Before changing the pose, styles, or cloth settings on the cloth items, click on the 
Clear button to clear the draping for the selected cloth items (the cloth item(s) 
must be selected in order to clear the draping). You will be asked to confirm 
removal of all draping animation from the affected cloth item(s). Click on OK to 
confirm or on Cancel to keep the current draping. Once the draping has been 
cleared, move the timeline scrubber to the first frame prior to redraping. 
 

TIP! If you re-drape and nothing happens, check to make sure you moved 
the scrubber back to the first frame of the animation (or any frame in between if 
you need to refine the draping without starting back at the beginning). 

30. To replay the draping, click on the Play button on the animation timeline. 
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